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1. Go to the 
Download and Install PowerPivot for Excel 

Microsoft Web site (http://go.microsoft.com/fwlink/?LinkId=155905). 
2. Download either the x86 (32-bit) or the x64 (64-bit) version of PowerPivot_for_Excel.msi 

installation program: 
a. To install the 32-bit version, click the Download button. The 32-bit version is the default. 

Clicking Download selects the default. 
b. To install the 64-bit version, scroll down the page and select the 64-bit installation 

package.  
3. Double-click the .msi file to start the Setup wizard. 
4. Click Next to get started. 
5. Accept the license agreement, and then click Next. 
6. Enter your name, and then click Next. 
7. Click Install. 
8. Click Finish. 

 

Start Excel. After you install the add-in, you can open the PowerPivot window by clicking the PowerPivot 
tab on the Excel ribbon, and then clicking PowerPivot Window. An empty PowerPivot window opens 
over the Excel application window. You can then use the Import Wizard to add tables of data, create 
relationships between the tables, enrich the data with calculations and expressions, and then use this 
data to create PivotTables and PivotCharts.. 

Verify Installation 

 

This tutorial examines International electronic sales over time and compare sales by product type, year, 
and country for Contoso Company. Imagine you are an analyst for an electronics company called 
Contoso Electronics. You want to examine sales over time and compare sales by product type, year, and 
country. Make sure that the following are installed: 

Tutorial: PowerPivot for Excel  

• Microsoft  
• Microsoft Excel 2010 

You will need the PowerPivot for Excel Tutorial Sample Data – Version 2. The sample data that is used in 
this tutorial is from the fictional company Contoso and is stored in Access databases and Excel 
worksheets. Note that you have to unzip the files and store them in your selected folder. 
 
ETL: Import data from multiple sources; Access databases and Excel worksheets 
 

1. Navigate to the location on your computer where you downloaded the samples and double-click 
Stores. You will use the stores data in a later lesson. 

To Create a Connection to an Access Database 

2. In the Excel window, on the PowerPivot tab, click PowerPivot Window. 
3. In the PowerPivot window, on the Home tab, click From Database and select From Access. 

This launches the Table Import Wizard which guides you through setting up a connection to a 
data source. 

4. In the Friendly connection name field, type ContosoDB from Access. 
5. In the Database name field, click Browse. Navigate to the location where you downloaded the 

sample files, select ContosoSales, and click Open. 
6. Click Next and verify that Select from a list of tables and views to choose the data to import 

is selected.  
7. You want to select from a list of tables and views, so click Next to display a list of all the source 

tables within the database.  
8. Select the check box for the following tables: DimChannel, DimDate, DimProduct, 

DimProductSubcategory, and FactSales. 
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1. Select the row for the DimProduct table and click Preview & Filter. 
To Filter the Table Data prior to Importing 

2. The Preview Selected Table window opens with all the columns in the DimProduct table 
displayed. 

3. Clear the checkboxes at the top of the columns for all the columns from ClassID through 
StockTypeName (a total of 15 columns) and then click OK.  

4. Notice that the words Applied filters are now displayed in the Filter Details column in the 
DimProduct row; if you click on that link you’ll see a textual description of the filters that you just 
applied.  

5. Now select the row for DimProductSubcategory and click Preview & Filter. 
6. Since you’re interested in only some of the products, you will apply a filter so that you import only 

the data for these categories. 
At the top of the ProductCategoryKey column, click the arrow and deselect 7 and 8. Categories 
7 and 8 include games and home appliances, and you don't want to include those in your 
analysis. 

7. At the top of the ProductSubcategoryDescription column, clear the checkbox. Since the 
descriptions are almost identical to the names, there is no need to import both columns, and 
eliminating unnecessary columns will make your workbook smaller. Click OK. 

 
Review your selections. If everything looks OK, click Finish. While importing the data, the wizard displays 

how 
many rows have been fetched. When all the data has been imported, a message indicating success is 
displayed. Notice that you imported more than 2 million rows from the FactSales table alone. Click Close. 
 

1. In the PowerPivot window, on the Home tab, click From Database and select From Access. 
This starts the Table Import Wizard which guides you through setting up a connection to a data 
source. 

To Add Data by using a Custom Query 

2. In the Friendly Name box, type Product Category Access DB. 
3. In the Database name field, click Browse. Navigate to the location where you downloaded the 

sample files, select ProductCategories, and then click Open. 
4. Click Next. 

 

1. Select the Write a query that will specify the data to import option, and then click Next. 
To Use the Query Designer Tool to Select the Data to Import 

2. In the Friendly Query Name box, type Product Category Query. 
3. Click Design to open the Query Builder window. 
4. Click Import and navigate to the location on your computer where you saved the samples.  
5. If you do not see the file listed, click the file down arrow and select All files (*.*). 
6. Select SQLQuery and then click Open. 
7. The SQL Statement appears in the window. This query selects all data from the ProductCategory 

table except GAMES and TOYS and HOME APPLIANCES.  
8. Click OK, Validate, and then Finish. A summary of the columns you are importing is displayed. 
9. When the import is finished, click Close. 
10. Rename the new table by right-clicking the Product Category Query tab and selecting Rename. 

Type ProductCategory and then click Enter. 
 

Copy and Paste from an External Excel Worksheet.  The Sales department has an Excel spreadsheet 
that contains data about the location of areas where Contoso is currently selling products. You will copy 
the data that you need from this worksheet, and paste it into your PowerPivot workbook. 

To Add Data by using Copy and Paste  

 
 
 



3 
 

1. Navigate to the location on your computer where you downloaded the samples and double-click 
Geography. This opens a new Excel worksheet and you are no longer in the PowerPivot window. 

To Copy and Paste from an External Excel Worksheet 

2. Highlight and copy cells A1 through J675. Be sure to select only this range of cells and not whole 
rows and columns. Selecting whole rows and columns imports empty cells, which might affect 
your ability to create relationships with this data. 

3. Back in your PowerPivot window, on the Home tab, click Paste. 
4. The Paste Preview dialog displays the new table that will be created. Make sure that the table 

data is correct, select Use first row as column headers, and then click OK. 
5. The new table is created in the PowerPivot window. To rename the table, right-click the tab, click 

Rename, and then type Geography. 
 

A Linked Table is a table that has been created in a worksheet in the Excel window, but is linked to a 
table in the PowerPivot window. The advantage of creating and maintaining the data in Excel, instead of 
importing it or pasting it in, is that you can continue to modify the values in the Excel worksheet, while you 
are using the data for analysis in PowerPivot. In the previous task the Geography table is static because 
after you pasted the data, it is not automatically updated. Linked tables, on the other hand, automatically 
reflect changes that were made to the source. Linked tables must reference Excel data found in a 
separate Excel window within the same PowerPivot workbook. 

To Add Data by using an Excel Linked Table  

 

1. In the Excel window, put your pointer in any of the cells of the Stores worksheet and format it as 
a table (CTRL+T). Be sure to select My table has headers. 

To Create a Linked Table 

2. Click OK 
3. The new table that will appear in the PowerPivot window always has the same name as the table 

in Excel. Therefore, you should give the Excel table a meaningful name before you create the 
linked table in PowerPivot. By default, Excel automatically generates names for tables (Table1, 
Table2, etc) but you can easily rename tables by using the Excel interface. 

a. Click the Design tab.  
b. In the Properties area, under Table Name: type Stores. Enter 
c. Copy stores worksheet 
d. Paste into powerpivot excel sheet 

4. On the PowerPivot tab in Excel, click Create Linked Table. This opens the PowerPivot window 
and you can see that a new table has been created – notice the Link icon on the tab. 

5. In the PowerPivot window, on the Linked Table tab, click Go to Excel Table to return to the 
source table in the Excel window. Change the value in cell C2 from 35 to 37. 

6. Return to the PowerPivot window; and you'll see that the corresponding row has now been 
updated to the new value as well. 

 

1. In the Excel window, click the File tab. 
To Save your PowerPivot Workbook 

2. Click Save As. The Save As dialog box opens. 
You will save the workbook as the default file type of Excel Workbook (*.xlsx). For a list of 
supported file types. 

3. In the File name text box, type PowerPivotTutorialSample and then click Save. 

 To Create Relationships between Tables 
Why Create Relationships? In order to perform any meaningful analysis, your data sources must have 
relationships between them. More specifically, relationships enable you to: 

• Filter data in one table by columns of data from related tables. 
• Integrate columns from multiple tables into a PivotTable or PivotChart. 
• Easily look up values in related tables using Data Analysis Expressions (DAX) formulas. 

Review Existing Relationships 
You already have data from three different sources in your PowerPivot workbook:  
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• Sales and product data imported from an Access database. Existing relationships were 
automatically imported for you together with the data.  

• Product category data imported from an Access database. 
• Data copied from, and linked to, an Excel spreadsheet that contains store information. 

 

1. In the PowerPivot window, on the Design tab, in the Relationships group, click Manage 
Relationships.  

To Review Existing Relationships 

2. In the Manage Relationships dialog box, you should see the following relationships, which were 
created when the first Access database was imported: 

Table Related Lookup Table 

DimProduct [ProductSubcategoryKey] DimProductSubcategory [ProductSubcategoryKey] 

FactSales [channelKey] DimChannel [ChannelKey] 

FactSales [DateKey] DimDate [Datekey] 

FactSales [ProductKey] DimProduct [ProductKey] 

3. Click Close. 
 

1. Click the Stores tab. 
To Create Your First Relationship 

2. Right-click the GeographyKey column header and select Create Relationship. 
The Table field and the Column field are auto-populated. 

3. In the Related Lookup Table field, select Geography. 
4. In the Related Lookup Column field, select GeographyKey. 
5. Click Create. 
6. When the relationship is created, an icon displays at the top of the column. Pause the pointer 

over the icon to display the relationship details. 
 

1. Click the Stores tab. 
To Create More Relationships between the data from Access and Excel  

2. Select the StoreKey column. 
3. On the Design tab, click Create Relationship. 

The Table field and the Column field are auto-populated. 
4. In the Related Lookup Table field, select FactSales. 
5. In the Related Lookup Column field, select StoreKey. 

Notice the icon next to the Related Lookup Column field. This tells you that this relationship is 
being created in the wrong order. When you create a relationship, you must select a column with 
unique values for the Related Lookup Column. 

6. Reverse the order. Move FactSales to the Table field and select StoreKey as the Column. 
Select Stores as the Related Lookup Table and select StoreKey as the Column. 

7. Click Create. 
8. Repeat the steps for DimProductSubcategory (as the table) and ProductCategory (as the 

lookup table), using the ProductCategoryKey column in both tables.  
9. Check that all relationships have been successfully created by clicking Manage Relationships 

and reviewing the list. 
 

1. In the PowerPivot window, select the FactSales table. 
Create a Calculated Column  

2. On the Design tab, in the Columns group, click Add. 
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3. In the formula bar above the table, type the following formula. AutoComplete helps you type the 
fully qualified names of columns and tables, and lists the functions that are available. For tips on 
how to use AutoComplete, see Build Formulas for Calculations. 
=[SalesAmount] - [TotalCost] - [ReturnAmount]. 

4. When you have finished building the formula, press ENTER to accept the formula. 
Values are populated for all the rows in the calculated column. If you scroll down through the 
table, you will see that rows can have different values for this column, based on the data that is in 
each row. 

5. Rename the column by right-clicking CalculatedColumn1 and selecting Rename Column. Type 
TotalProfit, and then press ENTER. 

 

1. In the PowerPivot window, on the PowerPivot Home tab, click PivotTable. 
To Add a PivotTable to Your Analysis 

2. Select New Worksheet.  
Excel adds an empty PivotTable to the location you specified and displays the PowerPivot Field 
List. The Field List displays two sections: a field section at the top for adding and removing fields, 
and a section at the bottom for rearranging and repositioning fields. 

3. Select the empty PivotTable. 
If you get an error message telling you the data list is no longer valid, right-click the table and 
select Refresh Data.  

4. In the PowerPivot Field List, scroll down and locate the FactSales table. 
5. Select the SalesAmount field. Ensure this field displays in the Values window of the Field List. 
6. In the DimChannel table, select the ChannelName field. Ensure this field displays in the 

Column Tables window of the Field List. 
7. In the DimDate table, select the CalendarQuarter field. In the PivotTable Field List, move this 

field from the Values box into the Axis Fields box. 
8. Rename the PivotTable by double-clicking Sum of SalesAmount in the first cell, erasing the 

current text, and typing Sales by Channel. 
9. Format the display of the data to make it easier to read and compare. Highlight the data cells, 

right-click and select Format Axis. In the Format Axis window, select Currency and make sure 
that 2 is selected in the Decimal places dropdown. Select $ for Symbol. Click OK. Change 
column widths if numbers aren’t readable. 

The Sales by Channel PivotTable lists the sum of sales for Contoso and for each Sales Channel, by 
quarters from first quarter 2007 through fourth quarter 2009. 
 

1. In the Excel window, on the PowerPivot tab, click PivotTable. 
To Add Another PivotTable to Your Analysis 

2. Select New Worksheet.  
Excel adds an empty PivotTable to the location you specified and displays the PowerPivot Field 
List. 

3. Select the empty PivotTable. 
If you get an error message telling you the data list is no longer valid, right-click the table and 
select Refresh Data.  

4. In the PowerPivot Field List, scroll down and locate the FactSales table. 
5. Select the TotalProfit field. Ensure this field displays in the Values window of the Field List. 
6. In the PowerPivot Field List, locate the ProductCategory table. 
7. Select the ProductCategoryName field. Ensure this field displays in the Legend Fields window 

of the Field List. 
8. In the PowerPivot Field List, locate the DimDate table. 
9. Select the CalendarYear field. In the PivotTable Field List, drag this field from the Values window 

into the Axis Fields window. 
10. Rename the PivotTable by double-clicking Sum of TotalProfit in the first cell, erasing the current 

text, and typing Profit by Category. 
11. Format the display of the data to make it easier to read and compare. Highlight the data cells, 

right-click and select Format Cells. In the Format Cells window, select Currency and make sure 

http://technet.microsoft.com/en-us/library/gg399193.aspx�
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that 2 is selected in the Decimal places dropdown. Select $ for Symbol. Click OK. Change 
column widths if numbers are not readable. 

The Profit by Category PivotTable lists the sum of profits, by year, for each Contoso product category. 
These are simple analyses of your data. To dig deeper, you will add a PivotChart and Slicers. 
 

1. Click inside the PivotTable. 
To Delete a PivotTable 

2. In the PivotTable Tools tab, select Options. 
3. In the Actions group, click Select. 
4. Select Entire PivotTable. On the Home ribbon select Delete and then click Delete Sheet. 

 

1. Start on the worksheet that contains your Sales by Channel PivotTable.  
To Add a PivotChart to Your Analysis 

2. On the PowerPivot tab in Excel, click the arrow below PivotTable and select PivotChart. 
3. Select Existing Worksheet and click OK.  

Excel adds an empty PivotChart to the same worksheet that contains your Sales by Channel 
PivotTable. 

4. Select the empty PivotChart and in the PivotChart Tools tab, select Design and then Change 
Chart Type. 

5. Select the first chart in the Line group and then click OK. 
6. In the FactSales table, select the SalesAmount field. Ensure this field displays in the Values 

window of the Field List. 
7. In the DimChannel table, select the ChannelName field. In the PivotTable Field List, move this 

field from the Axis Fields box into the Legend Fields box. 
8. In the DimDate table, select CalendarQuarter. In the PivotTable Field List, move this field from 

the Values box into the Axis Fields box. 
The PivotChart and PivotTable now display the same data – in very different layouts. 

9. Format the display of the data to make it easier to read and compare. Right-click the axis 
numbers and select Format Axis.  

a. Click Number and in the Category list, select Currency. 
b. Set Decimal places to 0, and then click Close.  
c. Right-click the Sum of SalesAmount axis label and select Value Field Settings. 
d. Change Custom Name to Sales by Channel and then click OK. 

 
 
 

1. Start on the worksheet that contains your Profit by Category PivotTable.  
To Add Another PivotChart to Your Analysis 

2. On the PowerPivot tab in Excel, click the arrow below PivotTable and select PivotChart. 
3. Select Existing Worksheet and click OK.  

Excel adds an empty PivotChart to the same worksheet that contains your Profit by Category 
PivotTable. 

4. In the FactSales table, select the TotalProfit field. Ensure this field displays in the Values 
window of the Field List. 

5. In the ProductCategory table, select the ProductCategoryName field. Ensure this field displays 
in the Axis Fields window of the Field List. 

6. In the PivotChart Tools tab, select Design and click Change Chart Type. 
7. Scroll down and select the first Pie chart type and click OK. 
8. In the Chart Styles group, select the 3-dimensional style with a black background and click OK. 
9. On your pie chart, select the title (Total) and change it to Profit % by Category. 
1. Next, you add and format data labels. 

a. On your pie chart, right-click and select Add Data Labels.  
b. Right-click again and select Format Data Labels.  
c. Highlight Label Options, then select the Percentage checkbox and deselect Value. 
d. Click Close. Resize the chart to make sure that all product categories are displayed. 
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e. Resize the chart to make sure that all product categories are displayed. 
2. Save your PowerPivot workbook. Note: This PivotChart displays percentage values for each 

product category. Because FactSales and other tables are filtered, the percentages are 
percentages of total sales in six of the eight categories of Contoso products. 

 
These are simple analyses of your data. To dig deeper, you will add Slicers. Keep the PivotCharts in the 
workbook in order to complete the tutorial, but if you want to delete a chart at some point, follow these 
steps. 
 

1. To delete a PivotChart, click inside the PivotChart. 
To Delete a PivotChart 

2. Right-click and select Cut.  
Deleting the PivotChart does not delete any associated PivotTable reports or data. 

 

1. Click anywhere inside the Profit by Category PivotTable to display the PowerPivot Field List. 
Add Slicers to PivotTables  

2. In the PivotTable Tools area of the Excel ribbon, click Options. 
3. Click Insert Slicer. 
4. In the Insert Slicers window, locate the Geography table and select RegionCountryName. 
5. Under the DimChannel table, select ChannelName. 
6. Under the ProductCategory table, select ProductCategoryName. 
7. Under the DimProductSubcategory table, select ProductSubcategoryName. 
8. Click OK. 

 

1. Arrange the slicers so that they can all be seen. To move the Slicers, click the gray border and 
drag. 

To Format Slicers 

2. The title of the ProductSubcategoryName Slicer is truncated. To format this Slicer, right-click the 
Slicer and select Slicer Settings. 

a. In the Caption box, type Subcategory. 
b. Verify that Display header is selected. 
c. Click OK. 

1. Sometimes Slicers must be resized in order to display their contents correctly. Resize the 
RegionCountryName Slicer by adding columns. 

a. Right-click the RegionCountryName Slicer and select Size and Properties. 
b. Highlight Position and Layout. 
c. In the Number of columns dropdown, select 4. Click Close. 
d. Drag the corners until all content is visible.  

2. Continue to format your Slicers as needed. 

   

1. At Contoso we want to evaluate our sales profit trends by channel. Based on what we discover, 
we may have to redistribute marketing budgets and/or close channels. 

To Use Slicers to Analyze your PivotTable Data 

a. In the ChannelName Slicer, select Catalog. Catalog should now be the only shaded 
item in the Slicer list. 

b. By looking at the PivotTable you see that catalog sale profits are declining. 
c. One at a time, click Online, Reseller, and Store to reveal those profit trends. You see 

that online profits are increasing, store profits are decreasing and reseller profits are 
decreasing slightly. 

d. Clear the filters you have set by clicking the icon in the upper-right corner of the Slicer. 
2. Dig a bit further by slicing your profit data by subcategory and country. Here are several 

interesting things that you might discover: 
a. Profits have more than doubled for cellphone accessories, televisions, and recording 

pens with the biggest percentage increase coming from online sales. While most sales 
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were made in stores, store profit percentage increase was the lowest. Given that most 
sales come from stores, what can be done to maximize profits from this channel? 

b. Cellphone accessories profits took a significant jump in 2009 for the Reseller and Store 
channels. Prior to that, profit increase was fairly flat in those 2 channels. To what can this 
jump be attributed? 

c. Overall profits from the sales of televisions more than doubled from 2007-2009. However, 
most of that increase came in 2008 with very little profit increase seen in 2009. Why were 
profits flat in 2009 and how can they be increased? 

d. Sales of Desktops dropped significantly. With total profits of almost 260 million, only 21 
million came from catalog sales. Catalog sales saw profits drop from almost 10 million 
(2007) to 4 million (2009). Perhaps Contoso should close this channel? 

e. Profits in Asian countries are increasing whereas profits in European countries, and North 
America are decreasing. 

Contoso can use this information, and much more, to make intelligent business decisions. 
 

Slicers are one-click filtering controls that narrow the portion of a data set shown in PivotTables and 
PivotCharts. Slicers can be used in both Microsoft Excel workbooks and PowerPivot workbooks, to 
interactively filter and analyze data. 

To Add Slicers to PivotCharts  

In this task you will use PowerPivot Slicers to control what data appears in your PivotChart.  
 

1. Click anywhere inside the Profit % by Category PivotChart to display the PowerPivot Field List. 
To Add Slicers to a PivotChart 

2. In the PivotChart Tools area of the Excel ribbon, click Analyze. 
3. Click Insert Slicer. 
4. In the Insert Slicers window, locate the DimDate table and select CalendarYear and 

CalendarMonth. 
5. Under the Geography table, select RegionCountryName.  
6. Click OK. 

 

1. Arrange the Slicers so that they can all be seen. To move the Slicers, click the gray border and 
drag the Slicers. 

To Format Slicers 

2. Sometimes Slicers must be resized in order to display their contents correctly. 
a. Select the CalendarYear Slicer and resize it so that only 2007, 2008, and 2009 are 

displayed. 
b. Right-click RegionCountryName and select Size and Properties. 
c. Highlight Position and Layout. 
d. In the Number of columns dropdown, select 6. Click Close. 

3. By default, Slicer items are displayed in alphabetical and numeric order, with items with no 
data displayed last. To change this view: 

3. Right-click the CalendarMonth Slicer, and select Slicer Settings. 
4. Uncheck Show items with no data last. Click OK. 
5. Continue to format your Slicers as needed. 

 

6. Use the CalendarYear Slicer to explore profit by year. The PivotChart clearly shows the profit 
share increase for COMPUTERS and TV and VIDEO (at the expense of CAMERAS and 
CAMCORDERS) from 2007 to 2009. Profit share for the other categories shows almost no 
fluctuation. 

To Use Slicers to Analyze your PivotChart Data 

7. To dig even deeper, use the CalendarMonth Slicer. You will discover that CAMERAS and 
CAMCORDERS had the highest profit share in the latter months of 2007.  

8. Explore your data more by using the RegionCountryName Slicer. Clicking through the countries 
reveals many interesting facts. 

9. Contoso can use this information to make intelligent business decisions 


